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About This Guide

Purpose

The TagMan® OpenArray® Genotyping Troubleshooting Guide provides information for
troubleshooting the OpenArray® system, including:

* Troubleshooting information for loading TaqMan® OpenArray® Genotyping
Plates.

 Troubleshooting information for data analysis in the OpenArray® SNP
Genotyping Analysis Software.

Prerequisites

This guide assumes that you have access to and are familiar with the procedures
provided in the TagMan® OpenArray® Genotyping Getting Started Guide (see “System
documentation” on page 67).

This guide uses conventions and terminology that assume a working knowledge of the
Microsoft® Windows® operating system, the Internet, and Internet-based browsers.

Safety information

Note: For general safety information, see this section and the “Safety” Appendix in the
TaqgMan® OpenArray® Genotyping Getting Started Guide. When a hazard symbol and
hazard type appear by an instrument hazard, see the “Safety” Appendix in the Getting
Started Guide for the complete alert on the instrument.

Safety alert words

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert word —
IMPORTANT, CAUTION, WARNING, DANGER —implies a particular level of
observation or action, as defined below:

IMPORTANT! —Indicates information that is necessary for proper instrument operation
or accurate chemistry kit use.

CAUTION! -Indicates a potentially hazardous situation that, if not avoided,
may result in minor or moderate injury. It may also be used to alert against
unsafe practices.

TagMan® OpenArray® Genotyping Troubleshooting Guide 5
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SDSs

WARNING! - Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

DANGER! - Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury. This signal word is to be limited to the most

extreme situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard symbols that are affixed to Applied Biosystems instruments.

The Safety Data Sheets (SDSs) for any chemicals supplied by Applied Biosystems or
Ambion are available to you free 24 hours a day. For instructions on obtaining SDSs,
refer to the “Safety” Appendix in the TagMan® OpenArray® Genotyping Getting Started

Guide.

IMPORTANT! For the SDSs of chemicals not distributed by Applied Biosystems or
Ambion contact the chemical manufacturer.

Safety labels on instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on
Applied Biosystems instruments in combination with the safety symbols described in

the preceding section.

Hazard
symbol

English

Francais

CAUTION! Hazardous chemicals. Read the Safety
Data Sheets (SDSs) before handling.

ATTENTION! Produits chimiques dangereux. Lire
les fiches techniques de siireté de matériels avant
toute manipulation de produits.

CAUTION! Hazardous waste. Refer to SDS(s) and
local regulations for handling and disposal.

CAUTION! Hot surface.

ATTENTION! Déchets dangereux. Lire les fiches
techniques de sdreté de matériels et la régulation
locale associées a la manipulation et U'élimination
des déchets.

ATTENTION! Surface brilante.

CAUTION! Class 2(ll) visible and/or invisible laser
radiation present when using the instrument and
barcode scanner. Do not stare directly into the beam
or view directly with optical instruments.

CAUTION! UV LIGHT HAZARD. UV light may harm
your skin and eyes. Keep at least 25 cm distance.

ATTENTION! Rayonnement visible ou invisible d'un
faisceau laser de Classe 2(ll) en cas d’ouverture et
de neutralisation des dispositifs de sécurité. Ne pas
regarder le faisceau directement ou au travers d’un
instrument optique.

ATTENTION! Dangers liés aux rayons UV. Les
rayons UV peuvent endommager votre peau et vos
yeux. Gardez une distance de plus de 25cm.
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Hazard

symbol English

Francais

f CAUTION! Moving parts. Crush/pinch hazard.

ATTENTION! Pieces en mouvement, risque de
pincement et/ou d'écrasement.
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CHAPTER 1

Guidelines for the TagMan®
OpenArray® Genotyping Plates

This chapter provides:

* Guidelines for handling and loading the TagMan® OpenArray® Genotyping
Plates (page 10)

* Detailed procedures for viewing the ROX™ dye image file, using the Image]
software (page 13)

The image file can help you find problems caused by incorrectly loading and/or
handling the genotyping plates.

¢ A troubleshooting table that illustrates common problems that can be seen in the
ROX dye image files (page 18)

Workflow

This chapter is intended to be used as supplemental information for Chapter 3 of the
TaqgMan® OpenArray® Genotyping Getting Started Guide (PN 4377476), “Prepare the
TagMan® OpenArray® Genotyping Plates.” The workflow is:

1. Prepare for loading.

2. Place a TagMan® OpenArray® Genotyping Plate in an OpenArray® AutoLoader
Plate Holder.

3. Load the OpenArray® AutoLoader Tip Blocks.
4. Run the OpenArray® AutoLoader.

5. Seal the TagMan® OpenArray® Genotyping Plates.

TagMan® OpenArray® Genotyping Troubleshooting Guide 9
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Guidelines for handling the plates

Guidelines for handling the plates

To ensure that you obtain successful results with the genotyping plates, follow the
handling procedures provided in Chapter 3 of the TagMan® OpenArray® Genotyping
Getting Started Guide. In particular, be sure to follow the guidelines listed below.

* Wear gloves that are one size smaller than the size you typically wear, to help
prevent excess glove material from contacting the genotyping plate during
loading.

¢ Hold the genotyping plate by the edges, at the end opposite from the barcode. Do
not touch the through-holes

o Within 1 hour after opening the plate packaging, load the genotyping plate with
sample, place the loaded plate in a TagMan® OpenArray® Genotyping Case, then
seal the case.

e If you drop a loaded genotyping plate, discard it in the appropriate waste
container.

Guidelines for loading the plates

To ensure the genotyping plates are successfully loaded with sample, follow the
loading procedures provided in Chapter 3 of the TagMan® OpenArray® Genotyping
Getting Started Guide. In particular, be sure to follow the guidelines listed below.

Procedure in Chapter 3 of the

Getting Started Guide Guideline

“Prepare for loading” Before you begin the sample loading procedure, be sure the OpenArray® Plate Guide
Set, OpenArray® AutolLoader Tip Blocks, and OpenArray® Autoloader Plate Holder
are completely clean and dry. Residual water prevents the samples from loading
correctly into the genotyping plates. Detailed cleaning procedures are in Appendix A
of the TagMan® OpenArray® Genotyping Getting Started Guide.

“Place a TagMan® OpenArray® Properly align the genotyping plate in the plate holder. The genotyping plate should
Genotyping Plate in a plate reach all the way to the right of the plate holder.
holder”

10 TagMan® OpenArray® Genotyping Troubleshooting Guide
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Chapter 1 Guidelines for the TagMan® OpenArray® Genotyping Plates

Procedure in Chapter 3 of the

Getting Started Guide Guideline
“Load the OpenArray® After placing the plate guide on the OpenArray® 384-Well Sample Plate, be sure that
AutolLoader Tip Blocks” the plate guide sits flat on the benchtop. The plate guide should not be tilted by the

sample plate beneath it. To check the plate guide position, gently slide the plate guide
across the benchtop. If the plate guide is not aligned correctly, it slips toward the base
of the sample plate.

Do not press firmly when inserting the OpenArray® Loader Tips into the tip block. Let
the tips drop into the tip block slots.

After the tips are placed into the tip block, slide the tip block up and down (25 to 50
times), until the tips are filled to 1 mm above the bottom edge of the tip block. Visually
inspect the tip block to ensure that:

e The tips are filled to 1 mm above the bottom edge of the tip block.

e There are no air bubbles.

You can remove the tip block to look at the tips. When you replace the tip block to load
more sample, be sure to:

e Level the tip heights.

e Keep the tip block in the same orientation. If you turn the tip block around, the
samples will mix together and become contaminated.

HENE R R

it
CVVUVUVUVUVVY

“Run the OpenArray® When placing the tip block into the AutoLoader:
AutoLoader"— Set up the 1. Align the tip block with the metal guide pins on the AutoLoader.
AutolLoader

2. Bring the tip block straight down, without tilting it.

IMPORTANT! Perform this step slowly and evenly to prevent improper sample loading
(for example, too much sample or not enough sample).

Be sure the tip heights are level:

e Gently slide your finger across the tops of the tips so that the tip heights are level.
Or

e Gently rest another tip block on top of the tips until the tip heights are level, then
remove the tip block.

TagMan® OpenArray® Genotyping Troubleshooting Guide 1



Guidelines for loading the plates

Chapter 1 Guidelines for the TagMan® OpenArray® Genotyping Plates

Procedure in Chapter 3 of the
Getting Started Guide

Guideline

“Run the OpenArray®
AutoLoader - Load the sample”

When removing the tip block, slowly pull the tip block straight up, without any rocking
motion. To prevent rocking, it may be helpful to hold the tip block with your index

finger and thumb, and press your remaining fingers against the AutolLoader surface.
Removing the tip block in this manner may prevent liquid bridges in the stop position.

4
N

Liquid bridge

When removing the genotyping plate from the plate holder:
1. Place the plate holder on a flat surface.

2. Push the latch down, then carefully lift the genotyping plate from the plate holder
with one hand.

3. With the other hand, grasp the edge of the genotyping plate and lift it out.

“Seal the TagMan® OpenArray®
Genotyping Case”

When inserting the genotyping plate into the genotyping case, align the genotyping
plate with the grooves in the case. Misalignment may cause surface rubbing, loss of
samples, and/or contamination.

12
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View the image file to find potential problems

View the image file to find potential problems

The ROX™ dye image files generated by the OpenArray® system can reveal potential
problems with an experiment. Use the Image]J software to open the ROX dye image

files.

Note: The Image] software is installed on the computer with the OpenArray® SNP
Genotyping Analysis Software. You can also download a free copy of the Image]
software from the Internet (from your Internet browser, search for Image]).

View the ROX™ dye image file

1.

On the computer desktop, double-click [§8] to start the Image] software. The
Image] toolbar is displayed.

L imapea 5

File Edit Image Process Analyze Plugins Window Help
B o|x|of~<|4]+ |\ |Ala|0| 2| ®[sxsulur 7| 48] >

Imaged 1.40g/Java 1.6.0_01 (364 commands, 30 macros)

Navigate to and open the Images folder: C:\Images.

Locate the ROX dye image file of interest.

The ROX dye image file is a *.tif file. The file name includes “TROX” and the date
the file was created.

9 v2 SOCOPOIOL7F4 TSpotFind 625.06 D20080731114332.f
[ v2 S0COPOIOL7F4 TSpotFind B25.06 D20080731114332_x.t
=8 v2 S0COPOIOL 7F4 TSpotFind 825.06 D20080731114332 .t
(@ v2 S0COPOIILIF2 TROX B25.02 D20080731114448.4F )
fg!] ¥2 SOCOPOIIL1F2 TROX B25.02 D20080731114448_x.tif

3 ¥2 SOCOPOIILIFZ TROX B25.02 D20080731114448_y.tif

E ¥2 SOCOPOI2LOF2 TDarkImage B25.01 D20080731114700.tif
59 v2 SOCOPOIBLZFS TFAM B25.00 D20080731 114918

[ v2 SOCOPOIBLZFS TFAM B25.00 D20080731114918 _x.tf

[ v2 SOCOPOIBLZFS TFAM B25.00 D20080731 114918 _y.t

[ v2 SOCOPOI4LOFS TDarkimage B25.01 D20080731115130.4F

4. To view the image file:

* In the Images folder, select the image file, then drag and drop the file on top
of the Image] toolbar.

Or

¢ In the Image]J toolbar, select File » Open, then navigate to and open the
image file.

TagMan® OpenArray® Genotyping Troubleshooting Guide 13
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View the image file to find potential problems

5.

The image opens in a dark window along with the B&C (Brightness and Contrast)
toolbar.

Note: If the B&C toolbar is not automatically displayed: from the Image]J toolbar,
select Image » Adjust » Brightness and Contrast.

1.85x1.63 cm (1376x1 208); 16-bit, 3.2MB

In the B&C toolbar, click Auto to brighten the image.

. ¥2S0COPOI1L1F2 TROX B24.82 D20081024084608.tif (50%) 5
1.85x%1.63 cm (1376x1208); 16-bit, 3.2MB
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View the image file to find potential problems

Chapter 1 Guidelines for the TagMan® OpenArray® Genotyping Plates

(Optional) View the SpotFind image file

If you are not able to view the barcodes using the B&C toolbar, use the Image] software
to open the SpotFind image file. Viewing the barcodes allows you to verify the
orientation of the genotyping plates (see “About the image file” on page 16).

1. Navigate to and open the Images folder: C:\Images.

2. Locate the SpotFind image file of interest.
The SpotFind image file is a *.tif file. The name of the SpotFind image file:
¢ Issimilar to the name of the ROX dye image file, but includes “SpotFind”
instead of “TROX.”
* Includes the date the file was created.

(@ v2 S0coPOIOL7F4 TSpotFind B25.06 D20080731114332.5)
=] v2 SOCOPOIOLTF4 TSpotFind B25.06 D20080731 114332_x.tif
= v2 SOCOPOIOL7F4 TSpotFind B25.06 D20080731114332_y tif
=] v2 SDCOPOIILIFZ TROX B25.02 D20080731 114448t

=] v2 S0COPOIILIF2 TROX B25.02 D20080731 114448 _x.tif

=] v2 S0COPOIILIF2 TROX B25.02 D20080731 114448 _y.tif

=] v2 50C0POIZLOF2 TDarkimage B25.01 D20080731114700.tf
=] v2 SOCOPOI3LZFS TRAM 625,00 D20080731 114918, 4

=] v2 50COPOISLZFS TFAM B25.00 D20080731 114918 _x.tif

=] v2 S0COPOI3L2ZFS TFAM B25.00 D20080731 114918 _y.tif

=] v2 S0COPOI4LOFS TDarkimage B2S5.01 D20080731115130.tF

3. Double-click the file name to view the SpotFind image file:

- ¥2 50C0P01 d B24.

= e
1.85%1.63 crn (1376x1208), 16-hit; 3.2MB
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View the image file to find potential problems

About the image file

Each ROX dye image file contains up to three genotyping plates. In the image file, the
genotyping plates should be oriented as follows:

* The barcode end of the plate is at the bottom of the image; the serial number end
of the plate is at the top of the image.

* The right image corresponds to the genotyping plate in position 1 of the
OpenArray® instrument. Position 1 is at the back of the instrument.

* The middle image corresponds to the genotyping plate in position 2 of the
OpenArray® instrument. Position 2 is in the middle of the instrument.
* The left image corresponds to the genotyping plate in position 3 of the

OpenArray® instrument. Position 3 is at the front of the instrument (closest to the
door).

! v2 SOCOPOI1L1F2 TROX B24.82 D20081024084608.tif (50%) 3

1.85x1.63 cm (1376x1208); 16-bit; 3.2MB

I =] N

Plate in Plate in Plate in
position 3 position 2 position 1

In the default view, you can see the overall appearance and loading patterns of the
genotyping plates. To:

Zoom in — Press the Ctrl and + keys.

Zoom out — Press the Ctrl and - keys.

Ensure that the assays have been spotted

16

To ensure that the TagMan® SNP Genotyping Assays have been spotted on the
genotyping plate, use the Image]J software to examine each through-hole for evidence
of the ROX dye.

1. Open the image file of interest, as described on page 13.

2. (Optional) Press the Ctrl and + keys to zoom in on the image.

TagMan® OpenArray® Genotyping Troubleshooting Guide
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View the image file to find potential problems

3. View each through-hole to determine if an assay has been spotted:

If the through-hole is...

Then the through-hole is...

Example

Extremely bright

Fully loaded. The through-hole
contains an assay, sample, and
master mix.

QooQOOCC

4 +++©+¢ .I

CUDUTUDU

Dark, but there is a light-colored
ring around it

Partially loaded. The through-hole
contains an assay, but it does not
contain sample or master mix.

g eisialwinlelals

| CUCUUODU

Completely dark, and there is no
light-colored ring around it

Slightly brighter than an empty
through-hole, but less bright than a
fully loaded through-hole

Empty. The through-hole does not
contain an assay, sample, or master
mix.

Partially loaded. The through-hole
contains sample and master mix,
but it does not contain an assay.

Qoo QQODC

| CUUUUODY

Jejsialnlalololes

| CUOUUOOY

TagMan® OpenArray® Genotyping Troubleshooting Guide
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Troubleshoot using the image files

Troubleshoot using the image files

Observation Possible cause Recommended solution

Volume in the through-holes is drawn | You touched the through-holes on the | e Wear gloves that are one size

out loaded genotyping plate. smaller than the size you typically
wear, to help prevent excess glove
material from contacting the
genotyping plate.

e Hold the genotyping plate by the
edges, at the end opposite from the
barcode. Do not touch the through-
holes

When inserting the genotyping plate Hold the case by its sides only and do
into the genotyping case, you not squeeze the case.
squeezed the case too tightly.

Circled areas show where
the volume in the through-
holes is drawn out.

18 TagMan® OpenArray® Genotyping Troubleshooting Guide



Chapter 1 Guidelines for the TagMan® OpenArray® Genotyping Plates

Troubleshoot using the image files

Observation

Possible cause

Recommended solution

Missing subarrays

e The OpenArray® Loader Tips were
not leveled while in the OpenArray®
AutolLoader Tip Block.

e Excessive pressure was used when
leveling the tips.

No sample was loaded into the tips.

After the tip block is placed on the

AutolLoader, level the tips in one of two

ways:

e Gently glide your index finger over
the top of the tips.

e Gently rest an unused tip block on
top of the tips and remove.

After you load and level the tips,
confirm that the tips are loaded to

1 mm. If there are empty tips or tips
not filled to T mm, return the tip block
to the plate guide and tap again to load
and level the tips. If any tips remain
empty, note the empty tips for future
sample loading.

The tip block may be dirty or may not
be completely dry after cleaning. A
dirty or wet tip block can cause
“sticky” tips that do not sit correctly in
the tip block.

Ensure that the tip blocks are
completely dry. Use 100% ethanol as
the final rinse and allow the tip blocks
to completely dry before using them.
To expedite drying, use nitrogen gas
from a tank and air gun.

Dark areas show where the
subarrays are missing

TagMan® OpenArray® Genotyping Troubleshooting Guide
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Troubleshoot using the image files

Observation Possible cause Recommended solution
Progressively empty through-holes. Not enough volume was loaded into e Be sure to use the correct volume:
the OpenArray® Loader Tips. 5 uL per through-hole. Volumes

In the figure below, note the direction
of loading (indicated by the blue
arrow); as sample is loaded to the left,
volume has run out and the through- * The volume level must be at least
holes are empty. 1 mm above the bottom of the tip
block. Be sure to tap 25 to 50 times
and examine the level prior to
loading onto the AutolLoader.

less than 5 uL result in poorly
loaded subarrays.

Ig“
£
: 554
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Troubleshoot using the image files

Observation Possible cause Recommended solution

Empty through-holes in the middle of | Air bubbles were in the OpenArray® e Use proper pipetting techniques to
a subarray Loader Tips. avoid introducing bubbles when

loading volume into the 384-well
sample plates.

e Be sure to spin the 384-well
sample plates before you load the
genotyping plates. Spin at
1000 rpm for 1 minute.

mﬂ= #
i S

i |IIIII.IIIIII

H & t
essesss
11
11

}

Enlarged view of the circled
subarray.

IIIIII%I“III
|

338 3382t 3
s
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Troubleshoot using the image files

Observation

Possible cause

Recommended solution

A serpentine pattern appears in one or
more subarrays.

The genotyping plate is not sitting
tightly against the stop block on the
right side of the plate holder.

Use tweezers to push the genotyping
plate as far to the right as possible.

Too many bubbles and/or foam in the
tip.

There is not enough volume in the
sample plate. Correct the volumes as
needed on the rest of the sample
plate. To ensure that all the volume is
at the bottom of the wells, centrifuge
the sample plate before loading the
tips.

The AutolLoader is misaligned.

Contact Applied Biosystems Technical
Support for servicing.

Enlarged view of the circled
subarray. The arrow
indicates the direction that
the AutoLoader loaded the
samples in.

22
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Troubleshoot using the image files

Observation Possible cause Recommended solution
Most of the start positions show low or | e The tips were not leveled. e When loading the tip block, allow
no sample loaded. o The tips were pressed too hard in the tips to fall into the tip block
the tip block and/or during tip after ejecting them from the
leveling. pipette.
o There are air gaps and/or bubbles | ¢ When leveling the tips, gently move
in the ends of the tips. your index finger over the top or

use an unused tip block placed on
the top of the tips for leveling. Do
not apply pressure when
performing these actions.

e Before you place the tip block in the
AutolLoader, confirm that the ends
of the tips are loaded (no air gaps).

23 i 338 :
II!I - BRSO TS a: O . S Byl Iﬁll o i»«
= = e SESS A : IE ____I! E !I!N o8
$335s 333iiise $33iii.s SRIIIEC $ittis fittsis 334
i i i
ll!l !!!I i eiy L R !!!! !I!!
1 3 3 5
ssssaze sssse sses ssess. sssssess sssss
3 3 2 3 3
24 e 3 b2t
kg e _II Rslss 408G 5 L !I!!
sasacss 2 sssrs as
: 35 13332 FIEEH SEEials
= E KSR
= M AT eI e RO ) RS
Enlarged view of the circled
P sssse sessss- . sssss subarray. The arrow
indicates the direction that
. s Siaiie Reeeris ULl S - the AutolLoader loaded the
s33333: 3! 233352 33223338 2iiiilir sniiin samples in.
ik e Ssasss it e = i ::u
4324 3E 'K.X + 243 - P33 e
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Troubleshoot using the image files

Observation Possible cause Recommended solution
Liquid bridges appear at the stop The tip block was removed too quickly, | Remove the tip block slowly. See the
location on the sample plate surface. | leaving excess volume. guidelines on page 12.

Enlarged view of the circled
subarray. The arrow
indicates the direction that
the AutoLoader loaded the
samples in.
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Chapter 1 Guidelines for the TagMan® OpenArray® Genotyping Plates

Troubleshoot using the image files

Observation Possible cause Recommended solution

Bubbles appear to float around on the | Bubbles formed when the genotyping | ¢ When filling a case with glue, be

sample plate surface. case was sealed with the OpenArray® sure to follow the illustrated
Sealing Glue. procedures in Chapter 3 of the
TagMan® OpenArray® Genotyping
Getting Started Guide.

e If you notice a bubble after filling
the case with glue, use a clean
pipette to remove the bubble before
curing the glue.
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1 Chapter 1 Guidelines for the TagMan® OpenArray® Genotyping Plates
Troubleshoot using the image files

Observation Possible cause Recommended solution
Numerous white specks appear The lens is dirty/dusty. Over time, dust and other debris can
throughout the image. accumulate on the lens inside the

OpenArray® instrument. Although this
debris is not detrimental to the overall
data, it can affect various datapoints.
Regularly clean both sides of the lens
using a lint-free cloth.
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Chapter 1 Guidelines for the TagMan® OpenArray® Genotyping Plates

Troubleshoot using the image files

Observation

Possible cause

Recommended solution

There are empty through-holes along
the outer edges of the genotyping
plate

The sample plate is
not properly sealed.

Evaporation occurred because the
sample plates were not properly
sealed.

Note: Evaporation usually occurs
along the borders of the sample
plates.

Be sure to properly seal the sample
plates. If you need to store the sample
plates, store them as follows:

e Store sample plates containing
sample only (2.5 pL) at 20 °C.

e Store sample plates containing
sample and master mix (5.0 pLJ at
4°C.

The sample plate is
properly sealed.

TagMan® OpenArray® Genotyping Troubleshooting Guide
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Chapter 1 Guidelines for the TagMan® OpenArray® Genotyping Plates

Troubleshoot using the image files

28 TagMan® OpenArray® Genotyping Troubleshooting Guide



CHAPTER 2

Guidelines for Data Analysis

This chapter provides:

Workflow

An brief overview of genotyping experiments and scatter plots in the
OpenArray® SNP Genotyping Analysis Software (page 30)

Tips for performing data analysis in the OpenArray software (page 34)

A troubleshooting table that illustrates common problems that can be seen in the
scatter plots in the OpenArray software (page 42)

Information about degraded DNA (page 55)
Procedures for determining sample population size (page 57)

This chapter is intended to be used as supplemental information for Chapter 5 of the
TaqgMan® OpenArray® Genotyping Getting Started Guide, “Analyze the Run Data.” The
workflow is:

1.

2.

View the results.

(Optional) Modify clustering parameters.
(Optional) Modify project files (*.nix).
(Optional) Publish data.

(Optional) Perform downstream analysis using the AutoCaller"" Software.
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2 Chapter 2 Guidelines for Data Analysis
About genotyping experiments

About genotyping experiments

A genotyping experiment (also known as an allelic discrimination experiment) is an
endpoint experiment used to determine the genotype of unknown samples. With this
experiment type, you can differentiate a single nucleotide polymorphism (SNP).

A genotyping experiment determines if unknown samples are:
* Homozygotes (samples having only allele 1)
* Homozygotes (samples having only allele 2)
* Heterozygotes (samples having both allele 1 and allele 2)

About the scatter plots

About the dyes

Custom TagMan®
SNP Genotyping
Assays

Pre-Designed
TagMan® SNP
Genotyping Assays

30

The OpenArray software genotypes the DNA samples from the genotyping plate
simultaneously. The software algorithmically clusters the sample data, then assigns a
genotype call to the samples of each cluster according to its position on the plot.

The clustering of datapoints can vary along the X-axis (Allele 1), Y-axis (Allele 2), or
diagonal (Allele 1-Allele 2). This variation results from differences in the dye
fluorescence intensity after PCR amplification. The table below shows the correlation
between fluorescence signals and sequences in a sample.

A substantial increase in... Indicates...
VIC® dye-labeled probe fluorescence only Homozygosity for Allele 1
FAM™ dye-labeled probe fluorescence only Homozygosity for Allele 2
Both VIC® and FAM™ dye-labeled probes Allele 1-Allele 2 heterozygosity
fluorescence

The dye label information for a Custom TagMan® SNP Genotyping Assay is listed in
the Assay Information File (AIF) that ships with the assay:

* The VIC® dye-labeled probe is listed under the Reporter 1 sequence
e The FAM™ dye-labeled probe is listed under the Reporter 2 sequence.

The dye label information for a Pre-Designed TagMan® SNP Genotyping Assay is
listed on the Assay Details page on the Applied Biosystems web site:

1. Go to www.appliedbiosystems.com.
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About genotyping experiments

2

2. In the I Want to Buy box, click TagMan® SNP Genotyping Assays.

I Want to Buy...

® TagMan® Gene Expression
Assays, Plates & Arrays

® TagMan® MicroRNA Assays

'® TagMan® SHP Genotyping
Assays

® Resl-Time PCR Reagents & Kits

@ Customn Primers & Probes
® Assays & Customn Products
abbides

3. Under SNP Genotyping Assays, click TagMan® SNP Genotyping Assays.

Genotyping Assays & Plates

To find all of our SNP genotyping assays, including capillary
electrophoresis-based assays, please go to SNP Genotyping
Assays (under Genotyping).

= TaqMan® Gene Copy
Number Assays

= SNP Genotyping
Assays
Custom TaqM o SNP
Genotyping Assays
TaqMa Drug
Metabolism Genotyping
Assays
TaqMan® Pre-Developed
Assay Reagents for
Allelic Discrimination

* Copy Number Assays
Custom TagqMan® Copy
Number Assays
TaqMan® Copy Number
Assays
TaqMan® Copy Number
Reference Assays

aqMan® SNP
Genotyping Assay Sets

TaqMan® OpenArray®
Genotyping Plates

4. On the TagMan® SNP Genotyping Assays page, follow the prompts to search for
the assay of interest.

TagMan® SNP Genotyping Assays
\

Related Products |

Ordering Information Product Description | Literature/Support

Assay Search Specifications

The World’s Largest

Printer-Friendly Yersion
Collection
With 4.5 million SNP assays available, ﬁ \
including 3.5 million HapMap SNPs, 70,000

cSNPs and 160,000 validated assays, 1. Search for SHP
TaqMar SHP Genotyping Assays make it Genotyping

easy to perform SNP genotyping studies wiih Assays:

the precision of TagMan® reagent-based
chemistry. TagMar Assays provide SNP

Quick Search by

Keyword
detection capabilities, high-confidence
results, and will help accelerate your T
research. N

Go to Full

Search

How to Order Assays

Type of |Ordering Ordering Method
Assay Method 1 |2

Download free
SNPbrowser™

2. Choose the
appropriate
Assays for your
needs.

at the top

and than

TagMan® OpenArray® Genotyping Troubleshooting Guide

Human Software, and use 3. Add them to
Pre- Click the this genotyping your Shopping
Designed Assay project design tool Basket and check
Assays Search tab o order SHNP out.

assays from our

of this page database.

Download SNP
Browser
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About genotyping experiments

5.

On the search results page, click the assay ID to open the Assay Details page.

» Assay dbSNP | JSNP ID
ID )]
()

Made to Functionally rs28897675 BRCA1
Order Tested

Alignment Map

On the Assay Details page, the dye label is listed with the context sequence. In the
example below, allele 1 (A allele) is detected by the probe labeled with VIC dye,
and allele 2 (C allele) is detected by the probe labeled with FAM dye.

Additional Information®

dbSNP s & $535528979 , £535528979 , 5569196514

Location (NCBI Build 36) Chr, 17 - 38500338

Minor Allele Frequency AB HapMap
Caucasian - - CEPH (CEU) --
African-American - - Yoruba (YRI) =-
Chinese - - Han Chinese (HCB) - -
Japanese - - Japanese (JPT) --

Allele normendature
Species Homo sapiens
Set Membership

Context Sequence( ([VIC/FAM]) GCTGCACGCTTCTCAGTGGTGTTCTCATTATFACTG‘

Polymorphism AfC, Transversion Substitution

What does a good scatter plot look like?

32

A good scatter plot shows the following characteristics:

The no template controls (NTCs) are present and distant from any clusters.

The clusters are tight (that is, all samples within a cluster are close to the center of
the cluster).

The clusters are clearly separated from one another.

There are no outliers or failed samples.

The figure below illustrates a good scatter plot.
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About genotyping experiments
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Chapter 2 Guidelines for Data Analysis

Tips for data analysis

Tips for data analysis

After an imaging run, the OpenArray software automatically calls genotypes. If the
automatic calls are not suitable for your experiment, you can modify the clustering
parameters as discussed in the TagMan® OpenArray® Genotyping Getting Started Guide.
In addition, you may find the following tips helpful when analyzing the data:

Add or edit sample information for individual samples (this page)
Edit the allele information (page 35)

Remove outliers to adjust the scale (page 37)

Sort data (page 38)

View a sample across assays (page 38)

Use the Enhanced Spread Display option (page 39)

Export genotyping results (page 41)

Add or edit sample information for individual samples

34

You can manually add or edit sample information for individual samples, then save
the changes to the project file (*.nix) and/or plate data file (*.spd).

Note: You can automatically add sample information for multiple samples by
importing a sample information file (*.csv). Refer to Chapter 4 of the TagMan®
OpenArray® Genotyping Getting Started Guide or see Appendix B of this guide.

1.

2.

Click Edit to open the Sample Information dialog box.

211 No Call No Call

BEJ33 NA17230 VF VF B

Auto Don't Call Outlier Edi...

Double-click the sample ID to edit, then add or edit the information.
mple Informat For BEJ40

Plate Area # Plate Layout

mber
oot N (|

Selected Samples
| Sample ID | Dilution &
| Na17102

NAT4474

NAT7103

NAT4476

NAT7104

NAT7110

NAT7105

NAT7112

NAT7108

NAT7113

NAT?107

NAT7116

NAT?T14

NAT7202

NAT7201

NAT7204

NAT7203

TagMan® OpenArray® Genotyping Troubleshooting Guide



Chapter 2 Guidelines for Data Analysis 2
Tips for data analysis

3. Save the *.nix file:
¢ Select File » Save to save the changes to the current *.nix file.

Or
¢ Select File » Save As to save the changes to a new *.nix file.

4. Save the changes to the plate data file (*.spd):

a. Click Add.
b. In the Add/Remove Plate Files dialog box, select the appropriate *.spd file,
then click Save Files.

Add/Remove Plate Files

Files Included In Project

Remove Files | Add File... | Save Files... I Cancel
4

c. The Browse For Folder dialog box, select a save location, then click OK.

d. At the prompt, click Yes to overwrite the existing *.spd file.

OpenArray™ Data File Exists 1 .Z(J

! \_\ The Openarray™ data file C:\Documents and Settings\11-19-08111BE139.5pd already exists. Replace it?

I

e. Click Done. The *.spd file now contains the new allele information.

Edit the allele information
The OpenArray software automatically populates the VIC SEQUENCE and FAM
SEQUENCE columns in the Assays pane as follows:

* 'V for the VIC® dye sequence
* F for the FAM"™ dye sequence

|| VIC SEQUENCE | FAM SEQUENCE

C__29086771_20 ||V
C_3168383.10 ||V F
C__8376134_10 ||V F
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Tips for data analysis

If needed, you can change the alleles (for downstream analysis, for example):

1. Click in the appropriate cell, then enter the correct allele.

| VICSEQUENCE | FAM SEQUENCE
4
ks F

The OpenArray software automatically changes V and F in the Genotype String
column to the appropriate alleles.

Opendrray Seria... | Sample ID Genotype Stiing
BEJ33 NA17102 No Call
BEJ39 NA14474 (|aa)

2. Save the *.nix file:
* Select File » Save to save the changes to the current *.nix file.
Or
e Select File » Save As to save the changes to a new *.nix file.

3. Save the changes to the plate data file (*.spd):
a. Click Add.

b. In the Add/Remove Plate Files dialog box, select the appropriate *.spd file,
then click Save Files.

B x|

Files Included In Project

Remove Files | Add File... | Save Files... | Cancel

| 4

c. The Browse For Folder dialog box, select a save location, then click OK.
d. At the prompt, click Yes to overwrite the existing *.spd file.
k|

! \_\ The OpenArray™ data file C:\Documents and Settings\11-19-08111BE139.5pd already exists. Replace it?

e ] w |

e. Click Done. The *.spd file now contains the new allele information.
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Tips for data analysis

Remove outliers to adjust the scale
Marking and removing outliers from the scatter plot enables the OpenArray software
to rescale the plot to achieve a greater view of the overall sample set. In the example

below, the outlier is circled in blue.

In the plot, click the outlier to highlight the sample in the Samples pane.
©)

23931

1.

16715

9500

I =T T I

The OpenArray software automatically rescales the plot.
Note: Depending on the location of the outlier, the software may not rescale the

plot.
FAM Intensity
e
-4
| .
as21 -

| e

N4 I

i

3848 4689 5531

2164 3006
VIC Intensity
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2 Chapter 2 Guidelines for Data Analysis
Tips for data analysis

Sort data

Sort the data in the Assays pane or Samples pane:

¢ To arrange rows in ascending or descending order, click a column heading. A
small triangle appears, indicating which column performed the overall sort.

Samples Assa

Genoype Sing | [ AssaylD (-
BEJ40 NA14474 C__ 177483_10
BEJ40 NA14474 FF C____598677_1_
BEJ40 NA14476 FF C___ 940286_10
BEJ40 NA14476 FF C___1046426_10
BEJ40 NA17102 FF C___1079489_20
BEJ40 NA17102 FF C___1085595_10

¢ To rearrange columns, click and drag a column heading to the desired location.

View a sample across assays

You can view the same sample across several assays to evaluate the sample’s
performance from assay to assay. For example, you may want to track a sample’s
success rate or ensure that an NTC is always assigned No Call status.

1. In the Samples pane, select the sample(s) to track. The samples are circled in the
plot.

BEJ40 No Call No Call
BEJ40 No Call No Call

BEJ40 No Call No Call
BEJ40 No Call No Call

Sso | oot |_ovier | £

2. In the Assays pane, select each assay one at a time. The selected samples remain
circled in the plot for each assay that you select:

Y
9

£ &

~C__177489 100 - C__598677_1_ - ~ C__940286 101

i
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Chapter 2 Guidelines for Data Analysis 2
Tips for data analysis
Use the Enhanced Spread Display option

Use the Enhanced Spread Display option to incorporate a spread correction when the
clusters appear too close together. The OpenArray software applies the Enhanced
Spread Display option to the entire project, not to individual assays.

IMPORTANT! Using the Enhanced Spread Display option may adversely affect results
when you transfer the data to the Applied Biosystems AutoCaller™ Software.

To turn the 1. From the menu bar, select Edit » Project Settings.
Enhanced Spread
Display option on: 2. In the Project Settings dialog box, select the Advanced tab, then select the

Enhanced Spread Display checkbox.

fiiProject Settings E‘

Typical Advanced |

System Logging Level  |Some Information -
¥ Auto Classify Data in Draw Mode

¥ Enhanced Spread Display

Help

QK Cancel

In the example shown below, the VIC® dye homozygotes are compressed on the X

Restore
Defaults

axis.
FAMII’ll'E‘:Iusony

® -
3892 7..'..81}. ."‘
1838 ‘

s
G
To turn the 1. From the menu bar, select Edit » Project Settings.

Enhanced Spread
Display option off:
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Tips for data analysis

40

2. In the Project Settings dialog box, select the Advanced tab, then deselect the

Enhanced Spread Display checkbox.

In the example shown below, the VIC dye homozygotes are no longer compressed on
the X axis. Therefore, all samples can be correctly genotyped (call vs. no call).

FAM Intensity

8000

6260

2181

3334

2601
VIC Intensity

TagMan® OpenArray® Genotyping Troubleshooting Guide



Chapter 2 Guidelines for Data Analysis 2
Tips for data analysis

Export genotyping results

The Point and Draw tabs in the OpenArray software are not connected. For example,
when you analyze data in the Point tab, the Draw tab does not reflect that analysis.
Before you export genotyping results, be sure that the appropriate tab is active.

* In the example shown below, the data were analyzed in the Point tab, then
exported while the Point tab was active. The correct genotypes appear in the
exported table.

FAM Intensity
8000

- OpenArray.SerialNumber  Sample.SamplelD | C__ 940286 10.Genotype
BEJ40 NA17102 VvV
& BEJ40 NA14474 VF
- BEJ40 NA17103 FF
e BEJ40 NA14476 V'V
' g ' BEJ40 NA17104 VF
BEJ40 NA17110 VF
BEJ40 NA17105 VF
BEJ40 NA17112 vV
- BEJ40 NA17106 VvV
BEJ40 NA17113 A
. BEJ40 NA17107 VF
o . - A BEJ40 NA17116 vV
& BEJ40 NA17114 vV
Wy BEJ40 NA17202 VYV

¢ In the example shown below, the data were analyzed in the Point tab, then
exported while the Draw tab was active. Because the data were not analyzed in
the Draw tab, the exported data table displays No Call for all genotypes.

FAM intensity
5%

an OpenArray.SerialNumber  Sample.SamplelD C___ 940286_10.Genotype
BEJ40 NA17102 No Call
BEJ40 NA14474 No Call
BEJ40 NA17103 No Call
. or. L BEJ40 NA14476 No Call
L BEJ40 NA17104 No Call
BEJ40 NA17110 No Call
BEJ40 NA17105 No Call
BEJ40 NA17112 No Call
- BEJ40 NA17106 No Call
BEJ40 NA17113 No Call
. BEJ40 NA17107 No Call
. w | E BEJ40 NA17116 No Call
- BEJ40 NA17114 No Call
" wcmey - BEJ40 NA17202 No Call
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Troubleshoot using the scatter plots

Troubleshoot using the scatter plots

The TagMan® SNP Genotyping Assays are optimized for use with Applied Biosystems
recommended reagents, instruments, and thermal-cycling conditions (refer to the

TaqgMan® SNP Genotyping Assays Protocol for detailed information; see “Documentation
and Support” on page 67). If you experience problems with assay performance, be sure

that you have followed the Applied Biosystems protocols, then check the
troubleshooting table below.

Observation

Possible cause

Recommended solution

Poor cluster separation across most
assays. Clusters are too close together
to properly determine the genotypes.

The overall fluorescence intensity is
strong. For some assays, the
trajectories of the clusters merge
when too many cycles are run.

More-
cycles!

Fewer
cycles*

Adjust the thermal-cycling conditions:

¢ Reduce the number of cycles.
And/or
* Increase the annealing Tm.

Note: You cannot adjust the thermal-
cycling conditions for the OpenArray®
platform; therefore, you may need to
redesign the assay or you may need to
perform genotyping on an SDS
platform that allows you to adjust the
thermal-cycling conditions.

The genotyping plate was left at room
temperature for too long after thermal
cycling.

After thermal cycling, store the
genotyping plates at 4 °C, in the dark,
for up to 72 hours.

FAM Intensity
8921

7435

5948

4461

2974

o 888 17715 2663 3551 4439
VIC Intensity
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Troubleshoot using the scatter plots

Observation

Possible cause

Recommended solution

Diffuse clusters. Samples within a
given cluster are not close to the

Degraded DNA. Degraded DNA may
not amplify as efficiently as high-

Perform a gel analysis to visualize
quality of the DNA. Re-extract those

center. quality DNA, so fluorescence that are degraded or remove from the
intensities vary. analysis. See "“DNA preparation” on
page 55.
Genomic DNA is not properly Use a high-quality spectrophotometer
quantitated. Samples with differing or perform an RNase P quantitation
concentrations result in varied assay to determine the concentration
fluorescence intensities. Samples with | of each sample. Normalize as needed
lower starting quantities exponentially | (refer to the User Bulletin: Human DNA
amplify lower yields compared to Sample Quantification Protocol Using
samples with higher starting the RNase P Kit (see page 67).
quantities.
Pipetting errors. Poorly calibrated e Ensure that all pipettes are
pipettes, incorrect pipette tips, or calibrated on a routine basis and
inefficient technique result in varied use the recommended pipette tips.
volumes pipetted into the sample Consult the pipette manufacturer
plate, and in varied genomic DNA for proper testing and
concentrations. maintenance.
o Check the ROX™ dye levels.
Variation in the ROX dye levels may
indicate pipetting errors.
Expired reagents. Replace with fresh reagents.
Evaporation has occurred prior to Check the ROX™ dye levels after
loading the genotyping plate in the imaging. Variation in the ROX dye
case. levels may indicate evaporation.
Analyzing too many *.spd files in one | Reduce the number of *.spd files.
view may cause the clusters to Applied Biosystems recommends
become too diffuse for proper analyzing no more than 10 *.spd files
genotyping analysis. in one view.
FAM Intensity
8820 5:@‘.: -
7056 :. ’ ';"%’.':.
- @;.:a' C
5292 . ° 0":; Y".
o "‘_‘u ¥
0 847 \;lscg?me“sny 254 3388
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Troubleshoot using the scatter plots

Observation

Possible cause

Recommended solution

Too many failed samples. More than
the expected number of samples
failed to properly amplify.

Degraded DNA. Degraded DNA may
not amplify as efficiently as high-
quality DNA, so fluorescence
intensities vary.

Perform a gel analysis to visualize
quality of the DNA. Re-extract those
that are degraded or remove from the
analysis. See “DNA preparation” on
page 55.

Genomic DNA is not properly
quantitated. Samples with differing
concentrations result in varied
fluorescence intensities. Samples with
lower starting quantities exponentially
amplify lower yields compared to
samples with higher starting
quantities.

Use a high-quality spectrophotometer
or perform an RNase P quantitation
assay to determine the concentration
of each sample. Normalize as needed
(refer to the User Bulletin: Human DNA
Sample Quantification Protocol Using
the RNase P Kit (see page 67).

Pipetting errors. Poorly calibrated
pipettes, incorrect pipette tips, or
inefficient technique result in varied
volumes pipetted into the sample
plate, and in varied genomic DNA
concentrations.

e Ensure that all pipettes are
calibrated on a routine basis and
use the recommended pipette tips.
Consult the pipette manufacturer
for proper testing and
maintenance.

o Check the ROX™ dye levels.
Variation in the ROX dye levels may
indicate pipetting errors.

Expired reagents.

Replace with fresh reagents.

Evaporation has occurred prior to
loading the genotyping plate in the
case.

PCR inhibitors, ranging from organics
to non-organics, can cause samples to
fail amplification.

Check the ROX™ dye levels after
imaging. Variation in the ROX dye
levels may indicate evaporation.

Examine the purity of the DNA by
checking the:

o Ayyn/Aggq ratio, which should be
between 1.7 and 1.9. A ratio <1.7
indicates protein contamination.

o Ayyn/Ag3q ratio, which should be
similar to the Aygo/Aygg ratio. When
this ratio is <1.7, salts, solvents,
and alcohols may be present.

Evaluate the current DNA extraction
method and consider an alternative
protocol.

44
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Troubleshoot using the scatter plots

Observation

Possible cause

Recommended solution

FAM Intensity
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High fluorescence signal in the NTCs

Non-specific probe cleavage.

Perform proper bioinformatics on the
sequence, evaluate the SNP design,
and consider redesigning the assay.
Refer to Bioinformatic Evaluation of a
Sequence for Custom TagMan® SNP
Genotyping Assays.

The NTC is contaminated.

The probe is degraded.

The genotyping plate was incorrectly
stored.

Examine other assays for high
fluorescence signal in the NTCs.
Consider replacing the water used for
the NTCs (the water may be a possible
source of contamination).

Store the genotyping plates correctly.
Refer to the TagMan® OpenArray®
Genotyping Getting Started Guidefor
storage information.

FAM Intensity
14457

12851

0
'...
’."o
.

11244

9638

o

‘}'.r
&

8032

.
‘n‘O‘

6425

3213

1606

2501 3335

VIC Intensity

0 834 1667 469 5002

5836 6670 7503

TagMan® OpenArray® Genotyping Troubleshooting Guide

45



Chapter 2 Guidelines for Data Analysis
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Observation

Possible cause

Recommended solution

Trailing comet/tail. Samples within a
given cluster are spread along the
center line with varying fluorescence
intensities.

(Leading cause) Genomic DNA is not
properly quantitated. Samples with
differing concentrations result in
varied fluorescence intensities.
Samples with lower starting quantities
exponentially amplify lower yields
compared to samples with higher
starting quantities.

Pipetting errors. Poorly calibrated
pipettes, incorrect pipette tips, or
inefficient technique result in varied
volumes pipetted into the sample
plate, and in varied genomic DNA
concentrations.

Use a high-quality spectrophotometer
or perform an RNase P quantitation
assay to determine the concentration
of each sample. Normalize as needed
(refer to the User Bulletin: Human DNA
Sample Quantification Protocol Using
the RNase P Kit (see page 67).

e Ensure that all pipettes are
calibrated on a routine basis and
use the recommended pipette tips.
Consult the pipette manufacturer
for proper testing and
maintenance.

e Check the ROX™ dye levels.
Variation in the ROX dye levels may
indicate pipetting errors.

Expired reagents.

Replace with fresh reagents.

Evaporation has occurred prior to
loading the genotyping plate in the
case.

Check the ROX™ dye levels after
imaging. Variation in the ROX dye
levels may indicate evaporation.

PCR inhibitors, ranging from organics
to non-organics, can cause samples to
fail amplification.

Examine the purity of the DNA by
checking the:

o Ayuo/Argq ratio, which should be
between 1.7 and 1.9. A ratio <1.7
indicates protein contamination.

. A260/A23O ratio, which should be
similar to the Ay4p/Aggg ratio. When
this ratio is <1.7, salts, solvents,
and alcohols may be present.

Evaluate the current DNA extraction
method and consider an alternative
protocol.

Degraded DNA. Degraded DNA may
not amplify as efficiently as high-
quality DNA, so fluorescence
intensities vary.

Perform a gel analysis to visualize
quality of the DNA. Re-extract those
that are degraded or remove from the
analysis. See “DNA preparation” on
page 55.
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Troubleshoot using the scatter plots

Observation Possible cause Recommended solution
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A single cluster appears in the plot.

The minor allele frequency (MAF) may
be low.

Check the MAF for the SNP. A larger
sample size may be required to see
the minor allele. See “Sample
population size” on page 57.

The SNP may be a pseudo-SNP, non-
polymorphic SNP, or non-informative
SNP for the target population.

Verify that itis a SNP using dbSNP and
examine the SNP for a population-
specific MAF.

Note: dbSNP is an NIH database; go
to www.ncbi.nlm.nih.gov/projects/
SNP.
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Chapter 2 Guidelines for Data Analysis
Troubleshoot using the scatter plots

Observation

Possible cause

Recommended solution

More than three clusters appear in the
plot.

A non-target SNP under a primer or
probe may result in off-cluster data.
The location of the non-target SNP
under the primer or probe, as well as
the MAF, influences the extent to
which the cluster pattern is atypical.
The number of individuals exhibiting
this pattern depends on the allele
frequency of the non-target SNP. You
may see additional clusters (“angle
clusters”] or a lack of amplification of
the sample when there is an additional
polymorphism under the primer.

A SNP under a probe can result in an
outlier that falls between the
heterozygote and one of the
homozygotes (an angle cluster) or an
outlier that has the same angle as a
cluster but trails behind the main
cluster (a vector cluster).

The occurrence of one or more extra
or missing chromosomes leading to
an unbalanced chromosome
complement, or any chromosome
number that is not an exact multiple of
the haploid number.

e To confirm the presence of another
SNP under the probe or primer,
repeat the experiment and evaluate
overall assay performance:

- Do the assay results appear in
tight clusters?

- Do clusters have good
separation?

e Perform proper biocinformatics on
the sequence, evaluate the SNP
design, and consider redesigning
the assay. Refer to Bioinformatic
Evaluation of a Sequence for Custom
TagMan® SNP Genotyping Assays.

e Verify the presence of the outlier.
Examine the sample’s performance
in other assays to rule out
problems caused by this particular
sample, such as sample impurity
or degradation. Search the public
databases (for example dbSNP) to
see if the additional SNP has been
discovered. Perform comparative
sequencing on the subjects to
identify any undocumented SNPs
present under the primer or probe.
The presence of extra SNPs may
cause angle clusters or vector
clusters.

Note: dbSNP is an NIH database; go
to www.ncbi.nlm.nih.gov/projects/
SNP.
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Chapter 2 Guidelines for Data Analysis 2
Troubleshoot using the scatter plots

Observation Possible cause Recommended solution

The assay is not in Hardy-Weinberg A SNP is on the X chromosome. Confirm that you have selected the
Equilibrium (HWE). appropriate TagMan® SNP Genotyping
Assay and confirm its location in the
genome.

An assay detecting a SNP on the X
chromosome detects two alleles in
female samples, but only one allele in
male samples. Males are hemizygous
for this SNP (only one copy).

A SNP is on the Y chromosome.

The assay detects a SNP on the Y
chromosome. Only male samples are
detected; they are hemizygous (one
copy only) for this SNP. There are no
heterozygotes for this SNP. The female
samples do not amplify at all, but
cluster with the NTCs.
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Troubleshoot using the scatter plots

Chapter 2 Guidelines for Data Analysis

Observation

Possible cause

Recommended solution

A gene has a copy number
polymorphism.

Note: A copy number polymorphism
for a gene may or may not appear as
an anomaly in the plot.

If an individual is homozygous with
more than three copies of the gene
and each copy has the same genotype,
the data will likely appear in the
homozygous cluster.

If an individual is heterozygous with an
odd number of copies and the copies
have different genotypes, the data will
likely fall between the clusters for the
heterozygote (T:A) and the
homozygote (A:Al.

. Evaluate the overall assay

performance:

¢ Do the assay results appear in
tight clusters?

¢ Do the clusters have good
separation?

. Repeat the experiment to confirm

the presence of the off-cluster
sample.

. Examine the sample’s performance

in other assays to rule out
problems caused by this particular
sample, such as sample impurity
or degradation.

. Perform a literature search for

documentation of copy number
polymorphisms for the gene.

. Perform comparative sequencing

on the subjects to identify any
undocumented SNPs present
under the primer or probe; extra
SNPs may cause angle clusters.

. Perform a TagMan Gene Copy

Number Assay (PN 4331182 -
human) on all samples to
determine the copy number for the
gene in which the polymorphism
resides. For species other than
human, determine an appropriate
Copy Number Assay to use, if
possible.
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Troubleshoot using the scatter plots

Observation Possible cause Recommended solution

All samples failed to amplify. Numerous problems can cause complete failure of an assay. In addition to the
previously mentioned issues in this table, consider the following:

A phenol/chloroform DNA extraction e Use molecular biology-grade
method was used. phenol/chloroform, and remove all
traces of phenol.

e Consider a bead-based or column-
based extraction method.

The DNA sample contains impurities. | Dilute the DNA sample 1:10 to dilute

impurities.
The DNA sample was not properly Use an Applied Biosystems control
prepared. human gDNA (PN 4312660) to

determine if the problem arises from
the sample preparation.

Lower-grade reagents were used. Lower-grade reagents may contain
PCR inhibitors. Use molecular
biology-grade reagents in all assay-
related experiments, including DNA
preparation.

Heparin was used as an anti- If your sample DNA is extracted from
coagulant. blood, do not use Heparin as an anti-
coagulant as it can inhibit PCR. Use
EDTA as an alternative.

Samples failed to amplify on the Contact Applied Biosystems Technical
OpenArray® platform, but amplified Support.
on a real-time PCR system.

FAM Intensity

298

s .
LR
-

1232 2174 3116 2058 5000
VIC Intensity
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Troubleshoot using the scatter plots

Observation Possible cause Recommended solution
Double clustering. Each cluster is Genomic DNA is not properly Use a high-quality spectrophotometer
comprised of two clusters. quantitated. Samples with differing or perform an RNase P quantitation

concentrations result in varied
fluorescence intensities. Samples with
lower starting quantities exponentially
amplify lower yields compared to
samples with higher starting
quantities.

There are differences in fluorescence
intensities between two genotyping
plates in one project.

assay to determine the concentration
of each sample. Normalize as needed
(refer to the User Bulletin: Human DNA
Sample Quantification Protocol Using
the RNase P Kit (see page 67).

e If each genotyping plate was
prepared with different master
mixes, check the reagent expiration
dates. Use only reagents that are
not past their expiration date.

e Analyze the genotyping plates
separately.

The primer and probe sequences
target non-specific sequences.

Targeting non-specific sequences is
conventionally not an issue with
validated or pre-designed assays. In
rare instances, a duplicated region of
the genome that is represented in the
genomic assembly as a single location
produces this result for a pre-
designed assay. These duplicated
regions may be detected by BLAST
analysis of the assay content sequence
to the NCBI nr (non-redundant)
database sequences.

A SNP under a probe can result in an
outlier that falls between the
heterozygote and one of the
homozygotes (an angle cluster) or an
outlier that has the same angle as a
cluster but trails behind the main
cluster (a vector cluster).

To confirm the presence of another
SNP under the probe or primer, repeat
the experiment and evaluate the
overall assay performance:

e Do the assay results appear in tight
clusters?

e Do clusters have good separation?
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Troubleshoot using the scatter plots

Observation

Possible cause

Recommended solution

FAM Intensi
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e Perform proper bioinformatics on
the sequence, evaluate the SNP
design, and consider redesigning
the assay. Refer to Bioinformatic
Evaluation of a Sequence for Custom
TagMan® SNP Genotyping Assays.

e Verify the presence of the outlier.
Examine the sample’s performance
in other assays to rule out
problems caused by this particular
sample, such as sample impurity
or degradation. Search the public
databases (for example, dbSNP) to
see if the additional SNP has been
discovered. Perform comparative
sequencing on the subjects to
identify any undocumented SNPs
present under the primer or probe.
The presence of extra SNPs may
cause angle clusters or vector
clusters.

Note: dbSNP is an NIH database; go
to www.ncbi.nlm.nih.gov/projects/
SNP.
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Troubleshoot using the scatter plots

Chapter 2 Guidelines for Data Analysis

Observation

Possible cause

Recommended solution

Low levels of ROX™ dye

ROX™ dye is included in the TagMan®
OpenArray® Genotyping Master Mix. If
assay spotting fails or if sample
loading with the OpenArray®
AutolLoader fails, the OpenArray
software displays low levels of ROX
dye in the scatter plot, if the NTCs and

all other samples are properly labeled.

To confirm that the plot is reflecting
low levels of the ROX dye:

1. Start the ImageJ software, then
open the ROX dye image file (*.tif)
for the genotyping plate.

2. Compare the through-hole
locations (for example, A1c4) of the
dark spots in the image file to the
sample |IDs and locations in the
OpenArray software.

3. Note any trends.

For more information on using the
ImageJ software, see “View the image
file to find potential problems” on
page 13.

FAM lmms'ﬂv

5895

an

NTCs

1650
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DNA preparation

DNA preparation

Degraded DNA can affect PCR efficiency due to the presence of fewer template copies;
fewer template copies can affect the success of the TagMan® SNP Genotyping Assays.
Degradation can result from:

¢ Using very old DNA samples
e Using DNA extracted from Formalin Fixed Paraffin Embedded (FFPE) tissue
Note: For information on preparing DNA template from FFPE tissue, refer to the

Applied Biosystems publication DNA Genotyping from Human FFPE Samples —
Reliable and Reproducible (see “Documentation and Support” on page 67).

¢ Freezing and thawing DNA samples repeatedly

* Leaving DNA samples at room temperature

* Exposing DNA samples to heat, UV irradiation, or physical shearing

¢ Purifying DNA samples inefficiently so that residual nucleases remain
¢ Inefficient tissue preservation methods

* The pH level and/or salt concentration in the environment

Determine DNA quality

Run an agarose gel to determine if your DNA is degraded. Look for a tight band of
high molecular weight; smearing indicates degraded DNA. If the DNA is substantially
degraded, use more caution in interpreting your results. If possible, consider repeating
the assay using freshly prepared gDNA samples.

Agarose gel stained with ethidium bromide, showing two samples of human gDNA
subjected to heating at 99 °C for up to 30 minutes.

Sample &

Sarple B
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DNA preparation

The scatter plots shown below illustrate the effects of DNA degradation caused by

heating.
,
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Control, with no heating. After 1 minute of heating.
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e 2o ! 4
I After 10 minutes of heating. After 30 minutes of heating.
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Sample population size

Sample population size

Determine the sample population size

To determine if the size of your sample population is large enough to detect the minor
allele of interest:

* Go to www.appliedbiosystems.com, select the TagMan® Genotyping Assays
page, then search for the Minor Allele Frequency (MAF) for your assay.

Note: Applied Biosystems Custom TagMan® SNP Genotyping Assays do not
contain MAF data.

* Look for the MAF in the Assay Information File distributed with your assays.

* Search for allele frequency data using the public SNP identifier, available on
public web sites such as the:

— dbSNP at www.ncbi.nlm.nih.gov/SNP/index.html
— HapMap project at www.hapmap.org

Determine if the minor allele is detectable

Use the Hardy-Weinberg Equilibrium equation to determine if the minor allele is
detectable for a sample the size of your test population.

In the Hardy-Weinberg Equilibrium equation, 42 + 2gp + p2 = 1, the expected genotype
frequencies are 42, 2gp, and p2, where g and p represent the allele frequencies.

The values for g2, 2gp, and p2 correspond to the fraction of a given population that
would be homozygous for the minor allele (g9), heterozygous (gp), and homozygous
for the major allele (pp), respectively.

Multiply your sample size by the fraction for each allele to determine the number of
individuals with each genotype that you should expect to see. If your sample size is
small, you may not be able to detect rare alleles.

Example calculation  For a SNP with a MAF of 5% (0.05), the predicted frequencies are:

e 42=0.0025
e 2qp=0.095
e p2=0.9025

If you test of 20 gDNA samples from this population, you might expect:

* Homozygotes for the minor allele: 0.0025 x 20 = 0.05, or 0 individuals
* Heterozygotes: 0.095 x 20 = 1.9, or ~2 individuals
* Homozygotes for the major allele: 0.9025 x 20 = 18.05, or ~18 individuals

To detect one homozygote for the minor allele, it would take a sample size of
approximately 400 individuals (Sample Size = 1/MAF2).

TagMan® OpenArray® Genotyping Troubleshooting Guide 57


http:\\www.appliedbiosystems.com
http:\\www.ncbi.nlm.nih.gov/SNP/index.html
http:\\www.hapmap.org

2 Chapter 2 Guidelines for Data Analysis
Sample population size

58 TagMan® OpenArray® Genotyping Troubleshooting Guide



APPENDIX A

Access Information about the
TagMan® SNP Genotyping Assays

You can access information about the TagMan® SNP Genotyping Assays from Applied
Biosystems web site.

Note: For information on ordering the assays, refer to the Ordering TagMan® SNP
Genotyping Assays Quick Reference Card (see “Documentation and Support” on page 67).

Access information on the web site

1. Go to www.appliedbiosystems.com.

2. In the I Want to Buy box, click TagMan® SNP Genotyping Assays.

® TagMan® Gene Expression
Assays, Plates & Arrays

® TagMan® MicroRNA Assays

® TagMan® SNP Genotyping
fgsays

® Real-Time PCR Reagents & Kits

@ Custom Primers & Probes

® Assays & Custorn Products

3. Under SNP Genotyping Assays, click TagMan® SNP Genotyping Assays.

Genotyping Assays & Plates

To find all of our SNP genc
‘ electrophoresis-b ;
Assays (under Genotyping).

, including capillary
go to SNP Genotyping

TaqMan® Gene Copy SNP Genotyping
Number Assays Assays

Custom TagqMan® SNP

Copy Number Assays Genotyping Assays
Custom TaqMan® Copy TaqMan® Drug .
Number A: . Metabolism Genotyping
TaqMan® Copy Mumber Assays

Assavs TaqMan® Pre-Developed
TaqMan® Copy Mumber Agsf“‘-" Reagents for

Reference Assays

TaqMan® OpenArray®
Genotyping Plates
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A Appendix A Access Information about the TagMan® SNP Genotyping Assays

Access information on the web site

4. On the TaqMan® SNP Genotyping Assays page, follow the prompts to search for
the assay of interest.

TagMan® SNP Genotyping Assays
!

Literature/Support | Related Products |

| Ordering Information Product Description |  Specifications

Assay Search

The World’'s Largest

=
Collection
With 4.5 million SNP assays available, \
including 3.5 million HapMap SNPs, 70,00
cSNPs and 160,000 validated assays, 1. Search for SNP

Genotyping

TagMan® SHP Genotyping Assays make it

easy to perform SNP genotyping studies wifh Assays:
the precision of TaqMan® reagent-based Quick Search by
chemistry. TagMan® Assays provide SNP Keyword
detection capabilities, high-confidence
results, and will help accelerate your [
research.
Go to Full
Search

How to Order Assays m )
'

Type of |Ordering Ordering Method 2. Choose the

Assay Methoed 1 |2 appropriate

Download free Assays for your

SNPbrowser™ SSds:
Human Software, and use 3. Add them to
Pre- Click the this genotyping your Shopping
Designed assay project design tool Basket and check
Assays Search tab o order SHNP out.

at the top ~ assays from our
of this page database.

and than - ' s

Download SNP
Browser

5. On the search results page, view the assay information. For a description of the
each column, click @ . The column descriptions are also provided on page 61.

Ordering Information Assay Search

Your search for "TBRCA1L in All Text ' returned 745 results.
You can either search within these results or click Search Again below to refine

Product Description Specifications Literature/Support Related Products

your original search.
. . @ Search Help
( Species = ALL Allele Freqs = All defaults SNP Types = All SNP types Assay Set =

All assay sets)

Previous |1 ]2 |3 14567 ]8]9] 10| Next

Please Log In to add products to your Shopping Basket/Favorites, configure a product, or to view
products available for purchase in your country.

Export Results 25 items/p. ¥

rAvailability |* Assay dbSNP | JSNP ID ’Gene rGene [*SNP
@ Type Symbol | Name | Type
@

O 1. €__27859555_10 | Made to Functionally | - BRCA1 breast  Mis-sense |
Order Tested cancer  Intron
Alignment Map 1, Transition ¢
early
onset
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Column descriptions

Column descriptions

Column Description
Assay ID The Applied Biosystems Assay ID. This is a link to the SNP Genotyping Assay Details Report.
Mapped ID Batch ID search results. Indicates which search term corresponds to each search result.
Availability e Inventoried Assays: These TagMan® Genomic Assays have been previously manufactured,

passed quality control specifications, and are stored in inventory.

o Made to Order Assays: These TagMan® Genomic Assays are manufactured at the time of
order. Only assays that pass manufacturing quality control specifications are shipped.

Multiple Scales

Assay Type

Made to Order TagMan® SNP Genotyping Assays are now offered in multiple scales: Small,
Medium, and Large. Once you select your assays and place them in your Shopping Basket, and
if multiple scales are available for those assays, you may select their scales in the Shopping
Basket.

e Validated Assays: Validated assays are tested against four ethnic populations, consisting of
45 individuals for each population. Minor allele frequencies are determined and published
for each individual population tested. Validated assays have at least a minor allele frequency
of 5% in one population.

e Functionally Tested: Assays for human studies are functionally tested. The function test
consists of either 10 or 20 unique DNA samples comprised of a mixed ethnic population and
both male and female representation. The functional test data are used to ensure that
shipped assays meet minimum functionality criteria only. Minor allele frequency is not
calculated due to the small and mixed sample set used in the test. The functional test is
similar to the test performed for the Custom TagMan® SNP Genotyping Assay Service.

e TagMan® Drug Metabolism Assay: DME assays are tested against four ethnic populations,
consisting of 45 individuals in each population. Validation data for Caucasian and African-
American populations have been performed in replicates.

dbSNP/JSNP ID

The corresponding NCBI dbSNP cluster ID (rs #) and/or JSNP ID. The dbSNP ID is a link to
the corresponding record in NCBI dbSNP, and the JSNP ID is a link to the corresponding record
in the JSNP® database.

Gene Symbol

The gene symbol (for example, CALCB).

Gene Name

The gene name (for example, calcitonin-related polypeptide).

Minor Allele Frequency

Minor Allele Frequency indicates the number of occurrences of an allele seen in the total
number of chromosomes typed at the SNP site.

e AB: The Applied Biosystems Minor Allele Frequency data are derived from four ethnic
populations up to 45 individuals each: African-American, Caucasian, Chinese, and
Japanese.

e HapMap: The HapMap Minor Allele Frequency data are derived from specific ethnic
populations as part of the International HapMap Project: CEPH (CEU), Yoruba in Ibidan,
Nigeria (YRI), Han Chinese in Beijing, China (CHB), and Japanese in Tokyo, Japan (JPT).

e AGI: The AGI Minor Allele Frequency data are derived from two ethnic populations of 19-20
individuals each as part of the Applera Genome Resequencing Initiative: Caucasian and
African-American.

Note: Minor Allele Frequency values from different data sets may differ for a particular SNP.
This may be because the values were generated by different populations and different sample
sets.

Public Location

The SNP location on the NCBI public genome.
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Column descriptions

Column

Description

SNP Type

The relationship between the variation and any local gene features. One of the following
displays:

acceptor splice site
coding region
donor splice site
intergenic/unknown
intron

mis-sense mutation
nonsense mutation
Pseudoautosomal XY SNP
putative utr 3
putative utr 5
repeats

silent mutation

utr 3

utr 5

Allele Nomenclature

DME assays only. The allele nomenclature follows an international nomenclature system
created to address the need for a universal system to describe polymorphisms in DNA and
protein sequences. The allele nomenclature used indicates the gene name, the allele
designation, and the base changes associated with the polymorphism. For example, for
CYPTAT*IC g-3229 G>A:

CYP1A1 indicates the gene

1C indicates the allele

g indicates genomic DNA

-3229 indicates the nucleotide position from the start codon
G>A indicates the base change

There are three public nomenclature Web sites we referred to when creating the DME product
line:

The home page of the Human Cytochrome P450 (CYP] Allele Nomenclature Committee:
http://www.imm.ki.se/cypalleles/

The Arylamine N-Acetyltransferase (NAT) Nomenclature Web site: http://
www.louisville.edu/medschool/pharmacology/NAT.html

The home page of the committee mediating the naming of UDP Glucuronosyltransferase:
http://som.flinders.edu.au/FUSA/ClinPharm/UGT/

Please note that not all of the polymorphisms included in our DME assay collection have been
documented on a nomenclature site; therefore, not all of our assays will be associated with
public allele nomenclature.
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APPENDIX B

Import Sample Information
After Imaging

Applied Biosystems strongly recommends that you add sample information before you
begin imaging. (For procedures, refer to Chapter 4 of the TagMan® OpenArray®
Genotyping Getting Started Guide) Adding the sample information before imaging
ensures that the information is included in the plate data file (*.spd) that the
OpenArray® SNP Genotyping Analysis Software generates during an imaging run. If
needed, however, you can import the sample information into a *.nix or *.spd file after
imaging is complete.

Determine if the sample information was imported before
imaging

To determine if the sample information was imported into a *.nix or *.spd file before
imaging, view the Sample ID column in the Samples pane. If the sample information
was not imported before imaging, the Sample ID column is empty.

Opendiray Seria... | Sample ID
BEJ33 '
BEJ33
BEJ33
BEJ33
BEJ33
BEJ33
BEJ33
BEJ33
BEJ33
BEJ33
BEJ33

TagMan® OpenArray® Genotyping Troubleshooting Guide 63



Appendix B Import Sample Information After Imaging
Import the sample information after imaging

Import the sample information after imaging

1. If you have not done so already, create a *.csv file according to the procedures in
Chapter 2 of the TagMan® OpenArray® Genotyping Getting Started Guide.

2. Inthe OpenArray software, select File » Open, then browse to and open the *.nix
file of interest.

3. Click Edit (below the Samples pane) to open the Sample Information dialog box.

4. (Optional) In the Sample Plate Serial Number field, enter the unique identifier for
each sample plate.
Note: The unique identifier is the one you created when you prepared the sample
plates.

mple Inform: n For BYEDL

5. Import the sample information:

a. Click Import to open the Import Sample Plates dialog box.
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Import the sample information after imaging

b. Browse to and open the *.csv file to import. The sample information appears
in the Selected Samples pane.

IMPORTANT! Be sure to select a *.csv file that contains sample information
for all of the required loads.

imple Information For BYEOL

Plate Area #

Selected Samples
Load Number | Plate ID | Address | Sample ID
Al Na17102
NA14474
N&17103
NA14476
NAT7104
NAT7110
NAT7105
NaI7112
NA17108
Na17N3
NaI7107
Na17116
NAI7114
Na17202
NTC
NA17204
Na17203

c. Edit the sample information in each row, as needed.

6. From the Plate Area # dropdown menu, select the 12-well x 4-well area of the
sample plate that the samples were transferred from.

.ample Information For BVEOL
Tip
Load #  Samy rial Number Plate Area #

7. Save the *.nix file:
* Select File » Save to save the changes to the current *.nix file.
Or
* Select File » Save As to save the changes to a new *.nix file.
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(Recommended] Save the sample information to the *.spd file

(Recommended) Save the sample information to the *.spd file

After saving the sample information to the *.nix file, Applied Biosystems recommends
that you also save the sample information to the *.spd file. Saving the sample
information to the *.spd file ensures that the sample information will not be lost, even
if the *.nix or *.csv file is deleted.

1. In the OpenArray software, click Add.

2. Inthe Add/Remove Plate Files dialog box, select the appropriate *.spd file, then
click Save Files.

Files Included In Project
Done
Remove Files | Add File... | Save Files... I Cancel

| 4

3. In the Browse For Folder dialog box, select a save location, then click OK.

4. At the prompt, click Yes to overwrite the existing *.spd file.

5
! E The Openfrray™ data file C:\Documents and Settingsi11-19-08111BE)39.5pd already exists. Replace it?
Yes Mo |

5. Click Done. The *.spd file now contains the sample information.
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System documentation

The following documents are available for the OpenArray® system:

Document Description Part

number

OpenArray® System Site Provides information on preparing the customer site for the 4401171

Preparation Guide OpenArray® system.

TagMan® OpenArray® Genotyping | Provides troubleshooting information for TagMan® OpenArray® 4401671

Troubleshooting Guide Genotyping. To be used in conjunction with the TagMan® OpenArray®

Genotyping Getting Started Guide.

TagMan® OpenArray® Genotyping | Provides procedures for performing TagMan® OpenArray® 4377476

Getting Started Guide Genotyping.

TagMan® OpenArray® Genotyping | Describes the overall workflow and provides brief procedures for 4400402

Quick Reference Card

performing TagMan® OpenArray® Genotyping.

Related documentation

When using this guide, you may find the documents listed below useful. To obtain this
and additional documentation, see “Obtaining support” on page 68.

Document Part number
Application Note: DNA Genotyping from Human FFPE Samples - Reliable 137AP04-01
and Reproducible
Bioinformatic Evaluation of a Sequence for Custom TagMan® SNP 4371003
Genotyping Assays
Ordering TagMan® SNP Genotyping Assays Quick Reference Card 4374204
TagMan® SNP Genotyping Assays Protocol 4332856
User Bulletin: Human DNA Sample Quantification Protocol Using the 4342582
RNase P Kit
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Documentation and Support
Obtaining support

Obtaining support

For the latest services and support information for all locations, go to:
www.appliedbiosystems.com

At the Applied Biosystems web site, you can:

* Access worldwide telephone and fax numbers to contact Applied Biosystems
Technical Support and Sales facilities.

* Search through frequently asked questions (FAQs).
¢ Submit a question directly to Technical Support.

* Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents.

¢ Download PDF documents.
¢ Obtain information about customer training.

¢ Download software updates and patches.
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